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About This Guide

The Type 2 Liverpool Ringing Simulator allows sensors, attached to one or more real tower bells or
teaching dumb bells, to be connected to a computer Simulator Software Package such as Abel?,
Beltower? or Virtual Belfry*. This allows you to extend and augment the teaching and practice
opportunities in your tower.

This brief Configuring Beltower Guide shows you how to configure the Beltower Simulator Software
Package to work with the Type 2 Liverpool Ringing Simulator.

Other project guides are available for the Abel and Virtual Belfry packages.

First Steps
This guide begins from the point that you have completed building and installing your Type 2
Liverpool Simulator hardware, and are now ready to configure Beltower to work with the simulator.

For guidance on building and installing the Type 2 Liverpool Simulator, please refer to the Build &
Installation Guide. For detailed technical information, see also the Technical Reference Guide.

If you want to use multiple PCs concurrently, please refer the Multi-PC Guide for information on
building either the Second PC module or the Basic Serial Splitter module. The Second PC module
allows two PCs to be used concurrently, the Basic Serial Splitter up to a maximum of 16.

Next Steps
This is not a detailed guide to using Beltower. Please refer to the Beltower documentation and help
for more information on the usage and configuration of the application.

This is also not a guide to using a simulator in teaching and practice. For guidance in this area the
ART® publication Teaching with Simulators is recommended, available from the ART shop®.

2 https://www.abelsim.co.uk/

3 https://www.beltower.co.uk/

4 https://www.belfryware.com/
5 Association of Ringing Teachers
5 https://shop.bellringing.org
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Beltower Copyrights & Licensing
Beltower is a copyright software product ©D. J. Ballard, made available under the Beltower Licence
Agreement included with the software.

Please ensure your copy of Beltower is properly licensed.

Beltower can be ordered from https://www.beltower.co.uk/.

Sensors Configuration

Configuration of the Beltower Simulator Software Package to use the Simulator Interface should also
only need to be done once. All settings are saved in the Beltower configuration file. This example is
based on Beltower 2022 (12.82), screens and options may differ slightly in other versions.

To configure Beltower to use the Simulator Interface, carry out the following steps. This manual
described the minimum necessary to configure Beltower to use the Simulator Interface, for full
details on the overall configuration and features of Beltower please refer to the product
documentation.

e Start Beltower on the Simulator PC, and if prompted select Advanced Mode.

Welcome to Beltower

Select User Mode

Basic Advanced

[ Always Advanced - don't azk me again

Figure 2 — Beltower — Mode Selection
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e From the Settings... menu select Sensors (or press F12).

pns m Window Help
Animation... Fa
Display... Alt+F10
Changes Colours... Alt+F11

Bell Sounds, Swing Time & Odd Striking... F11
Yoiced Calls Chrl+F11
Sensors... F12

Preferences... Ctrl+F12

Figure 3 — Beltower — Settings Menu

e Inthe Input Mode dropdown, select Serial interface, and in the Input dropdown select the
correct serial interface COM port number for the Simulator Interface. Note that Beltower
requires the serial COM port number to be between 1 and 32 (for versions prior to Beltower
2016 the upper limit was 8). Refer to the Technical Reference Guide for instructions on
reconfiguring port numbers.

"\ BELTOWER - Sensors Settings ‘

nput Mode  Serial Interface: Bagley [ Master [

aenzor  loout Hin

Bell 1 COM1 - 1 Refrezh delayz from Box | File |
Bell 2
52"3 Ignore First Signal [T Debounce time I'IDEI

gz::é ActonPinHigh W High/Low Transitions [~

gg::g Apply delays in Test Sensar I_ MO Input Tenar Ab3 ::I

Eell & Beltower (+

— Call Switch alzo does:
Bel3 | i bon ¢

BellO I vI
Bl E Start/Stop Call Changes |none

gz"; End Ringing [Stand) Inu:nne "I
Bell B Dowrwards Inu:une "I

Bell C

Bell D Go method IAnDther call switch

Bob
Singl
Dlrr;ig:e [T Auto-Cal Go after IB v| strokes

E’g{;ﬂg [~ futgStand (+/-Cal]  aiter [4 <] stiokes

ThatsAll

Rnd/Hst Ok I Eancell Help |

Figure 4 — Beltower — Serial Input Mode
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e Ensure that the Apply delays in Beltower radio button is selected, and that both the Bagley
and Master check boxes are not ticked.

) BELTOWER. - Sensors Settings ‘

Serial interface Input Mode  Serial Interfacelﬁagley [T Master [T I

Senzor |nput Fin Delay

IEDM'I LI Refrezh delays from Blow | File |

Bell 2 400
52"3 amn [gnore First Signal [T Debounce time I'IDD

EZ::; igg Acton Bin High W High/Low Transitions [

Ez”? Apply delays in jgg Test Sensar |_ MIDI Input Tenar 463 =

Bell & Beltower & | 410 . )
Bell 9 VBl b~ | 410 — Call Switch alzo does:

Bell O 410 I vI
Bl E 400 Start/Stop Call Changes | none

Bell T 400 End Ringing [Stand) Inu:nne VI
Bell & 400

BelB 400 Dowrnwards Inl:lne "I

BelC 400
Bel D 400 Go method I.ﬁ.nather call switch
Bob

Singl
Dlrr;ig:e [T Auto-Call Go after IE shrokes

Extreme

B ounds [~ Auto-Stand [+4-Call]  after |4 "I shrokes
Thatsdl

Rnd/Rst Ok I Eancell Help |

Figure 5 — Beltower — Sensor Settings

e Double-click each delay timer value to show the up and down buttons.

") BELTOWER - Sensors Settings ‘

ISeriaI interface ;I Input Mode  Serial Interface: Baglep [ Masier [
Senzor  Input Fin  Delay ]

0 m Refresh delays fram Biox | File |
BE::% 480 lgnare Eirst Signal [~ Debounce time W

Figure 6 — Beltower — Editing Delays
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Set the delay for each bell to an appropriate value, so that the simulated bell sounds as

closely as possible to the same time as the real bell (this is best done with the real bell un-

silenced. Note that in Beltower the delay values are specified in 1/1000ths of a second

(milliseconds), in increments of 10ms. Refer to the notes on Delay Time Calibration later in

this guide.

), BELTOWER - Sensors Settings

LV

Senial interface

Input Mode  Senial Interface: Bagley [ Master [

Sengor

Bell 2
Bel 3
Bel 4
Bell &
Bell &
Bell 7
Bel &
Bell 9
Bell0
Bell E
Bell T
Bell &
Bell B
Bell C
Bel D
Bob
Single
Cnit
Extreme
Rounds
ThatsAll
Fnd/R =t

Apply delays i§
Belower (+
MEIl bax

Input  Pin b
COMT -

400
400
400
400
400
400
410
410

Refrezh delays from Blow | File |

[gnore First Signal [T Debounce time I'IDD
Acton Bin High W High/Low Transitions [
Test Sensor I_ MID Input Tenor Ab3 :I

— Call Switch alzo does:

Start/Stop Call Changes m
ErdRinging (Stand)  |none |
Downpwards Im
Go method I.ﬁ.nother call switch

[T Auto-Call Go after IB VI shrokes
[~ Auto-Stand [+4-Call]  after |4 "I shrokes

Ok I Eancell Help |

Figure 7 — Beltower — Sensor Delays

Click OK in the Sensor Settings window to close the window.

Save the new options by selecting Save Selections from the File menu. If the options have
changed, Beltower will also prompt for this when the program is closed.

Activating the sensor configuration is done in one of two different ways, depending on
whether Beltower is being used in Basic or Advanced mode.
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e |n Basic mode, select one of the Tower Bell Sensor(s) options from the dropdown shown

when the application starts.

Welcome to Beltower

Basic User Mode

& Tower Bells = Hand Bells

Select Ringing Mode

Tower Bell Sensors)
Liztirg - % ait for Enter Ringer's Place
| 1 | 1oL Ll [, L 1

= :
| | | Tower Bell Senzors] with Animation
i Towier Bell Sensorfz] with Co-operative Timing
Tower Bell Senzar(z) with Co-operative Speed
PTG P =

Interactive Ropes and Sthiking

Figure 8 — Beltower — Basic Mode

e When Beltower is running in Basic mode, the sensor configuration can be activated by
selecting Ring Options... from the Options menu (or press F8), then selecting Tower Bell
Sensor(s) from the Timing Options dropdown and clicking the Initialize button.

), BELTOWER - Ring Options ‘

Statt Seqnge [1234567890ETABCD  Free-Stike M| ¥ CallLook To + Stand F
Bingers' Bells Im Highlight [nput Place ¥ duto. Go [T after IE strokes
Muilti-Keys IJFKD— Open Hand Stroke Leads W duto, That's Al Im
Bell Senzors Im Ring Speed IF Auta-Stand [ after IE strokes

|—Iiming Elptinnsl-l Tower Bell Senzors) ;I— ﬂl—‘
Info. | Ok, I Cancell Help |

Figure 9 — Beltower — Basic Mode Options

10
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e When Beltower is running in Advanced mode, the sensor configuration can be activated by
selecting Ring Options... from the Options menu (or press F8), then checking the External
Sensors radio button, and clicking the Initialize button.

Start Seqnce Im Free-Strike | [¥ Call Laok To + Stand =
Ringers' Bells Im Highlight Input Flace [  duto Go [ after IE strokes
Multi-FKeps IJFKD— Open Hand Stroke Leads W Aubo. That's Al Im
Bell Sensors Im Ring Speed duto-Stand [ after IE stiokes

— Timing Elptinns—l Tower Bell Sensor(s) i Show Always [ —

Hand Eells [~ Show Animation —Bellz Input
Strike On [nput ¥ &uto- Stike + Animate Fey IEI % before striking

— Input Mode Co-gperative Timing Arimate on Input I~
" Flace keys Co-operative Speed Hand/Back  Altemate [
~ .

~ R KE_‘I'I Rl Calls Input+Display On Time [ Target Place [

O Belere] Semsms Call Splice at &mp Fow [T [T Dizplay Changes &k Kep-in [

ey UpDown Transttions [ Yoice Calls |285 % before | “/ait for Corect [nput I~

Wiizard Infa. Ok | Eancell Help |

Figure 10 — Beltower — Advanced Mode Options

e Beltower should now be configured to use the Simulator Interface. Test each bell in turn and
check that the simulated bells are correctly mapped to the real bells.

11
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Delay Timer Calibration

For accurate simulation of the real bells, the simulator requires that the delay timer for each bell is
set so that the delay applied after Simulator Interface sends the strike signal to the Simulator (at
exactly the point at which the real bell passes through bottom dead centre of its swing) results in the
simulator sounding at the same time that the open bell would have struck. This delay time is specific
to each bell, but for most bells is somewhere around 0.5s (or 500 milliseconds).

The simplest method of setting the timer values is to ring each bell open alongside the simulator.

e Start the Beltower on the Simulator PC.

e Ring each bell in turn, open, and compare the sound of the bell and the simulated sound
from the simulator.

e If the real bell sounds before the simulator, reduce that bell’s delay timer value.

e |f the simulator sounds before the real bell, increase that bell’s delay timer value.

e Repeat this process until the sound of the real bell and the sound from the simulator are as
close to coincident as possible.

e Repeat for each of the other bells in turn.

Tip: A useful starting point for delay timer values is to measure the period of oscillation of the bell
for small swings and set the timer to % of that value. Then fine tune the value as described above.

12
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Using Multiple PCs

If you want to use multiple PCs concurrently, please refer the Multi-PC Guide for information on
building either the Second PC module or the Basic Serial Splitter module. The Second PC module
allows two PCs to be used concurrently, the Basic Serial Splitter up to a maximum of 16.

A Multi-PC configuration typically allows more than one ringer (with headphones) to use the
simulator with a simulated band at the same time, each ringing a different physical bell.

Second PC Module & Basic Serial Splitter Module

From the point of view of Beltower, all PCs connected using either the Second PC module or the
Basic Serial Splitter module behave in a similar manner. All PCs receive all the sensor signals from the
Simulator Interface module, all the time.

Each copy of Beltower must be configured to respond to the desired bell or bells and filter out the
unwanted signals. This can be done by selecting the bell(s) required in the Bell Sensors field in the
Ring Options dialogue.

"\ BELTOWER - Ring Options

Start Seq'noe |1 2340EFE0ETABCD  Free-Stike [w
Bingers' Bells |1 2340EFEO0ETARBCD [+ [ after |8 strokes
b uilti-Feys |JFKD OpenHand Stroke Leads | Auto, That's &I [ On Retum

Bell Senzorz  [1234067390ETDCEA I Ring Speed |l33 [ after [4 gtrokes
Timing Options |T|:nwer Bell Senzorls) j Show

Infa. Ok Caricel | Help |

Figure 11 — Beltower — Ring Options (Bell Sensors)

Configuring the Interface
When multiple PCs are connected, only one PC can be used to configure the Simulator Interface
using a terminal emulator (as described in the Build & Installation Guide and the Multi-PC Guide).

The PC used for Interface configuration depends on the hardware in use. This is covered in the
Multi-PC Guide.
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